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HARDWARE REQUIRED 
IBM or 100% compatible computer, 386 or above 
2MB RAM required, 4 MB recommended 
5 1/4" 1.2MB (high density) or 3 1/2” floppy disk required 
Hard disk required, with at least 2.5MB free space 
Microsoft-compatible mouse required 
VGA with color or grey-scale monitor required 
Optional sound boards: Adlib or compatible, Soundblaster or compat¬ 
ible, Roland 

SOFTWARE REQUIRED 
MS- or PC-DOS 3.0 or above 

SimLife for DOS-based computers supports VGA graphics in 16 colors at 
640 x 480 resolution. On some Super VGA cards, SimLife will run in 16 
colors at 800 x 600 resolution. If you have a Super VGA card that SimLife 
supports, it automatically installs itself to run at 800 x 600. If you prefer. 
640 x 480, you can choose it during installation. 

SimLife is not copy protected. This is an ongoing experiment and a big 
leap of faith for us. We are trusting you not to give away copies of this 
game. Copy protection is a pain—for all of us—and we’d like to stop 
using it forever, but if SimLife falls victim to piracy, then we will revert 
to using protection on future products. 

SimLife takes a lot of memory—at least 2MB total, and at least 1750KB 
free (combination of base memory and extended memory). It will use 
more if you have it. In a large world with lots of plants and animals it can 
use as much as 16MB. In order for SimLife to even run on a DOS machine 
we had to include a DOS Extender by FlashTek as part of the program. 
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HER IF E 
QUICK-START 

GUIDE 
INSTALLING 

SIMLIFE 

STARTING SIMLIFE 

THE ON-SCREEN 
TUTORIAL 

Before playing or even installing SimLife, we recommend that you make 
and use backup disk copies, and keep the original disks in a sale place. 

SimLife must be installed to a hard disk before use. Here's how: 
1. Choose either the 51/4" or 31/2" floppy disks, depending on your 

computer, and put SimLife Disk 1 into your A: or B: floppy drive. 
2. Type A: [Enter] or B: [Enter], depending on your drive. 
3. Type INSTALL [Enter]. If you have trouble running the Install 

program, try it again, but type INSTALL /D [Enter], 
4. Before installation actually begins, you will be shown the Readme 

file. This file contains all the last-minute information about SimLife 
that was too recent to make it into the manual or this addendum. 
When you are done reading, hit the Escape key to continue with the 
Installation process. (You can always go back and read this file later 
with any text-viewer or word processor or run Install again.) 

5. Follow the instructions on the screen. You will be asked some 
questions. If you aren’t sure about the answer to any question, just 
accept the default answer—it should work. At one point you will be 
asked to remove Disk 1 and insert Disk 2. 

6. After the installation is done remove Disk 2 from your drive. 

After installation (see above), make sure you are in the SimLife directory, 
and type SIMLIFE [Enter], 

After starting SimLife, you will see the New Game Window. Click on the 
Tutorial button, then on Play Scenario to start the on-screen Tutorial. 
You will then be walked through the basics of SimLife. A special Tutorial 
Menu will appear to help you navigate and access special Help screens. 

You can start the on-screen Tutorial at any time by selecting New from 
the File Menu, clicking on Tutorial in the New Game Window, then 
clicking Play Scenario. 

There are two additional tutorials in the manual that will take you on a 
more complete tour of SimLife and demonstrate how to design, set up 
and carry out a SimLife experiment. 
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DOS VERSION 
FEATURES 
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•m their respective 

DASHBOARD AND 
CONTROL PANELS 

Dashboard with 
Map Window Control Panel 

Dashboard with 
Edit Window Control Panel 

BIOLOGY LAB AT 
SELECT LEVEL 

facility for taking TAKING 
SCREENSHOTS 

DOS Version 3 



HER IF E 
MOUSE AND 
KEYBOARD 

A mouse is required to play SimLife. It is possible to play SimLife without 
a mouse, but not worth the effort. Use a mouse. You’ll be glad you did. 
There are keyboard controls and shortcuts for many of the functions 
and settings in SimLife, and you’ll find that a combination of the mouse 
and keyboard is the fastest way to play. A Keyboard Chart of all key 
commands and shortcuts is found on the back page of this addendum. 

MOUSE BUTTONS 
When the manual or addendum refers to “clicking" the mouse, use the 

USING MENUS 

CLICKING, DOUBLE-CLICKING, AND DRAGGING 

. to it and “click.” Clicking with a mouse Is pressing and releasing the left 
mouse button. Clicking with the keyboard is pressing and releasing the 
Space Bar or the Insert key. 

To activate some functions you will need to “double-click," which is just 
clicking quickly twice in a row. 

There are also times when you need to move or “drag” something across 
the screen. To do this, point to the thing you want to drag, and press and 
hold the mouse button, Space Bar or Insert key. While still holding the 
button or key down, move the object with the mouse or cursor keys to 
the new location, then release the mouse button or key. 

Menus are used extensively in controlling SimLife, and are located at the 
top of the screen in the “Menu Bar.” Only the names of the menus show 
until you open them. To open a menu, move the cursor to it and click. To 

Escape key. Once a menu is open, you can use the right- and left-arrow 
keys to cycle through and open the other menus. 

There are keyboard shortcuts for opening menus: hold down the Alt key 
and press the first letter of a menu name to open it. {This doesn't work 
with the Speed menu since Alt-S opens the Simulation Menu. Sorry.) 
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Once a menu is displayed, you can use the up and down arrow keys to 
highlight the item you want, then click (mouse button, Space Bar or 
Insert key) to activate it. You can also highlight an item in an open menu 
by typing the first letter of the item. If there is more than one item in that 
menu beginning with the same letter, then repeatedly hitting the letter 
key will cycle the highlight through all the items beginning with that 

Many of the menu items can be activated with keyboard shortcuts 
without even opening the menus. See the Keyboard Chart on the back 
page of this addendum. 

All the action in SimLife happens in windows. You can have multiple 
windows open on the screen at once. Windows can overlap and cover 
each other. The window in “front” is the active window. If you click on 
any part of a window, it will be brought to the front and made active. For 
ease of use, leave a part of each open window showing so you can quickly 
activate it by clicking on the part that shows. 

OPENING WINDOWS 
Windows can be opened by selecting them in the Windows Menu. If a 
window is already open (on the screen) but not active, selecting it in the . 
Windows Menu will bring it to the front and activate it. Some windows 
can also be opened and activated by using the buttons on the Dashboard 
and the shortcuts in the Keyboard Chart on the back of this addendum. 

CLOSING WINDOWS 
Windows can be closed by clicking in the Close Box in the upper-left 
corner of the window. You can also close the active window with the 
keyboard command Control- - (minus on the number pad). 

HIDING WINDOWS 
Windows can be hidden (moved into the background without closing 
them) by activating another window, or by clicking on the Hide Box. You 
can also hide a window with the keyboard command Control-* (plus on 
the keypad). 

WINDOWS 

m 
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HHlife 
SI MOVING WINDOWS 

Most windows can be moved by clicking and dragging their Title Bar 
with the mouse. You can also move windows from the keyboard by 
hitting Control-P (for Position), then using the cursor keys to move the 
window. Hit Space or Insert when the window is where you want it. 

RESIZING THE EDIT WINDOW 
The Edit Window can be resized and reshaped by dragging the Resize 
Box in the lower-right comer of the window. You can resize the Edit 
Window with the keyboard by hitting Control-R, then using the cursor 
keys to move the Resize Box. Hit Space or Insert when the Edit Window 
is the shape and size you want. 

The Edit Window also has a Zoom Box in the upper-right corner. If you 
' click on this, the window will grow to fill the whole screen. Click on it 
again and the window will return to its former size and shape. Control- 
Z activates the Zoom Box from the keyboard. 

SCROTLING THE EDIT WINDOW 
The entire world cannot be displayed in the Edit Window at once. You 
must scroll the terrain in the Edit Window to see everything. 

One way to scroll is to hold down the Control key while using the arrow 
keys: the cursor will stay where it is, and the terrain will scroll. 

The simplest way to scroll is to move the cursor to any edge or comer 
of the screen with a mouse or with the arrow keys. These keys let you 
quickly move the cursor: 

HOME moves the cursor to the left edge of the screen. 
END moves the cursor to the right edge of the screen. 
PgUp moves the cursor to the top edge of the screen. 
PgDn moves the cursor to the bottom edge of the screen. 
5 (on the numeric keypad only) moves the cursor to the center of the 

If the Scroll Lock key is on, the Edit Window will not scroll when you 
move the cursor to the edge of the screen. 
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SAVING GAMES 
To save a game, select Save from the File Menu. If it has already be 
saved before, it will be re-saved under the same name in the same pla 

:, you will be presented with the Save Game 
the game and tell the computer where to 

save it. If you have already saved your game, but want to save it to a 
disk or directory, or you want to change its name, select Save As from 
the File Menu. To save a new game: 

1. Give the game a long, descriptive name [spaces are OK). 
2. Give the game a file name. (It must conform to the rules of DOS.) 

The extension .UF will be added to the file name by the compi 
3. Select a destination drive for the file by doubleclicking on a 

name. Doubleclick on [..] to move up to a parent directory, and 
doubleclick on subdirectory names to move down into them. 

4. Click OK or hit Enter. (Click Cancel or hit Escape to cancel.) 

The Tab key switches you between the two names and the list box. When 
you choose Save As, SimLife will pick a default file name for your game, 
consisting of the first six letters of the long name and a two-digit number. 
This wayyou can quickly save yourworld at different times and different 
stages of development. If you set Make Backup? to Yes, then the next 
time you save the game (not Save As) SimLife will rename your last saved 
version of the game to have a .BAK extension before saving the new one.' 
If you change your mind about loading a game, click on the Cancel 
button. On-screen Help is available—just click on the Help button. 

LOADING GAMES 
To load a game, first select Load from the File Menu. When the Load 
Game dialog box appears, doubleclick on a game’s name in the list box, 
or singleclick on it, then click OK to load it. Click Cancel or hit Escape 
to cancel file loading and close the Load Game dialog box. 

The current path is displayed near the top of the dialog box. Click on a 
file name in the list box to see the full game name above the path. If there 
are more games than can fit in the list box, use the scroll bar and arrows 
to search through them. Doubleclick on [..] to see what’s in the parent 
directory (if any). Doubleclick on other drives or subdirectories (if any) 
to see their contents. On-screen Help is available—just click Help. 

SAVING AND 
LOADING GAMES 
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BEL IF E 
FILES, EXTENSIONS 

AND DIRECTORIES 
Besides game files, there are a number of different types of files that can 
be loaded into and saved from SimLife. These files hold information for 
a group of plants (Herbarium), a single plant, a group of animals (Zoo), 

SimLife directory structure and a single animal. These extensions are used to mark each type of file: 
.PNT Single Plant .ANL Single Animal 
.ZAN Zoo (multi-animal set) .ZPL ETerbarium (multi-plant set) 

ORGOTS 
ANIMALS 

FANCIFUL 
FILTER 
HERBIVOR 
PREDATOR 
PREHIST 

.DU Data Logging File (standard text file) 

When SimLife installs itself onto your disk, it installs the following 
subdirectories (unless you change their names): 
SIMLIFE contains all the SimLife files, plus the following directories: 

GAMES contains the saved games described below. 
ORGOTS contains a number of SimLife life-forms, divided into the 

TEMPERAT following directories: 
ANIMALS contains directories of different types of animals. 
PLANTS contains directories of different types of plants. 

ZOOS ZOOS contains the multiple plant and animal sets. 

SOUNDS The sounds in SimLife will vary in both amount and quality depending 
on your computer, and on what type of sound board you have (if any). 
Most sounds in SimLife happen in response to your actions, but there are 
three sounds that occur to notify you of important events that you might 

Ooooh—this moan is the sound of an animal dying. 
Ooh-la-la—this is the sound of animals mating. 

These sounds will not be heard if your computer or sound card does not 
support the playing of digitized sounds. Digitized sounds are disabled 

BEYOND THE 
VALLEY OF THE 

SIMS 

SimLife is a powerful simulation engine that can be put to use in a number 
of different ways, both useful and silly. We’ve included a few saved 
games on one of the disks that show some of these uses (or abuses). Try 
them out. See if you can figure out what they are and why. The file 
GAMES.TXT, which can be found in the SIMLIFEXGAMES directory, 
briefly describes each saved game. 
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An advanced—but very useful—feature in SimLife is Data Logging. When 
you activate the Data Logging... item in the Technical Submenu of the 
Simulation Menu, the program will write a lot of data to disk in a standard 
text file. This information can then be loaded into a spreadsheet or 
other statistical analysis program, and you can make all the graphs 
and charts you could ever want. 

Warning: The Data Log file can get huge. Depending on the 
size of the world and the number of plants and animals in 
it, this file can take up to 100KB per game year. Make sure 

you have the disk space. 

When you activate Data Logging, you will be presented with a dialog 
box that lets you name the data file and tell the computer where to 
save it. The extension .dtl will automatically be added to the end of the 
file name. You may have to rename the file to have a .txt extension 
before you can import it into another program. 

DATA LOGGING FILE-SAVING OPTIONS 
In addition to the usual file-saving controls, you can set a few other 
options. 

APPEND TO EXISTING FILE 
Sometimes you might run SimLife with Data Logging, take a break (to 
work—or better yet, play SimCity®), then come back to SimLife later. If 
you want to continue Data Logging where you left off, and have the data 
go into the same data file you were using before, use the same file name 
and check this box. 

DATA BUTTONS (A.K.A. FLAGS) 
You can choose what data to save to disk by setting the various data 
buttons to Yes or No. If you hold down the Control key while setting one 
button, all the buttons will be set the same. 

An explanation of what information each button represents can be found 
starting on the next page, as part of the complete description of the Data 
Logging file format. 
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HMl IFF 
DATA LOGGING FILE FORMAT 
In order to make use of this data once you get it into a spreadsheet (or other program), you’ll need to know 

Each line in the data log file starts with the four-letter abbreviation, as seen next to each checkbox, that 
identifies the type of information the line contains, followed by one or more data fields. Fields are separated 
from each other by a single Tab. Lines are separated by a Return. The first data field is the simulation time, 
showing the year, day, and tick of the event being reported. On most lines, the next field is either a species 
or an Orgot (an individual SimLife Organism) identifier code, which consists of aflag indicating whether this 
is a plant or an animal species, the species number and version, and the specific organism if applicable. The 
remaining fields are different for each message type as noted. 

Type Year.Day.Tic Date Time Message 
NOTE 0000.000.000 92/06/01 17:12:51 “Log started.” 
These are human-readable messages that report when the data log was started or closed, as well as when 
a game is paused, the simulation time is reset to zero, or a game is loaded. 

Type Year.Day.Tic SpecieslD Event Message 
HIST 0000.000.000 1.19.01.000 2 “‘Wheatgrass’has only seeds left.” 
All messages that appear in the History window will be recorded to the data log as they occur. 

Type Year.Day.Tic SpecieslD Remaining Species Population 
DIED 0000.000.000 1.02.01.023 12 
This is a record of each plant or animal death. 

Type Year.Day.Tic SpecieslD New Species Population 
LIVE 0000.000.000 1.00.01.030 30 
Each time a new plant or animal is created or populated, the species identifier and unique orgot number 
of the new inhabitant is recorded. If the GENE checkbox is checked, the genetic makeup of the new organism 
is reported. 

Type Year.Day.Tic SpecieslD New Species Population 
BORN 0000.000.000 1.00.01.030 30 
Each time an animal is born, the birth is reported. If the GENE checkbox is checked, the genetic makeup of 

10 SimLife Addendum/Quick Start Guide 



Type Year.Day.Tic SpeciesID New Species Population 
SEED 0000.000.000 1.00.01.030 30 
Each time a plant sprouts from a seed, the event is reported. If the GENE checkbox is checked, the genetic 
makeup of the new plant is reported. 

Type Year.Day.Tic OrgotID OrgotlD 
MATE 0000.000.001 0.06.01.002 0.06.01.001 
Each time a pair of animals or plants mate, the event is reported. The first OrgotID is the female. 

Type Year.Day.Tic OrgotID OrgotID 
ASEX 0000.001.000 0.12.01.005 0.12.01.005 
Each time an asexual plant or animal becomes pregnant, the event is reported. Since the orgot is mating 
with itself, the OrgotID is duplicated for consistency with the MATE data format. 

Type Year.Day.Tic SpeciesID Number Killed 
KILL 0000.000.000 1.00.01.000 30 
Each time a plant or animal is manually killed, the death is reported. 

Type Year.Day.Tic SpeciesID Number Populated 
POPU 0000.000.000 1.00.01.000 30 
Each time a species is manually populated, the event is reported. 

Type Year.Day.Tic SpeciesID Daily Statistics 
DATA 0000.001.000 0.00.01.000 See below 
At the end of each simulation day, the census statistics for each active species are summarized. 

Type Year.Day.Tic SpeciesID Annual Statistics 
YEAR 0001.000.000 0.00.01.000 See below 
At the end of each simulation year, the census statistics for each active species are summarized. 

Type Year.Day.Tic SpeciesID Message 
DELE 0000.000.000 1.00.01.030 ‘SpeciesName’has been deleted. 
Each time a species is deleted, the event is reported. 

Type Year.Day.Tic SpeciesID Message 
CREA 0000.000.000 1.00.01.030 ‘SpeciesName’ has been created. 
Each time a new species is created, the event is reported. 
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BDERife 
Type SpeclesID SpeciesName 
LEGN 0.00.01.000 “Elephant" 
At the beginning of each data log is a legend or listing of each species identifier and species name. This can 
be used as a key to look up the name of a species from its identifier number. 

Type Year.Day.Tic OrgotID MotherslD Genetic Data 
GENE 0000.000.000 1.00.01.001 1.00.01.000 See below. 
Each time a plant or animal is populated or born, the genetic information for that individual is reported. 
Since animals have more genetic data than plants, animals have several additional fields in addition to the 
basic fields. 

DATA and YEAR Fields 
All of the following fields are recorded for DATA (daily census statistics) and YEAR (yearly census 
summaries) for each active species: 

Simulation time; SpeciesID; Total species population, including seeds for plants; For plant species, the 
number of seeds, if any; Species population, not including unsprouted seeds; Number of births or sprouts 
in this species; Number of deaths in this species; Amount of radiation accumulated in this species 
population; Food level for this species; Water level for this species; Health level for this species; Number 
of females in the species population; Average age of the species population; Average size of the species 
population; Total biomass of this species. 

GENE Fields for Plants 
These are the fields recorded for each individual plant: 

Simulation time; OrgotID; OrgotID of this orgot’s mother; Food Store gene; Water Store gene; Health Store 
gene; Height gene; Mutation gene; Life span gene; Stealth gene; Birth/Death gene; Movement/Food Source 
gene; Reserved gene (not used for genetics). 

GENE Fields for Animals 
These are the fields recorded for each individual animal. They are the same as the plant genes above, plus 
the following additional fields: 

Behavior gene; Vision gene; Food Action gene; Water Action gene; Health Action gene; Food Danger gene; 
Water Danger gene; Health Danger gene; Gestation Time gene; Gestation Size gene; Metabolism/Gender/ 
Share Food gene; Adult Age gene; Weapons gene; Turn Style gene; Persistence gene; SpeciesO attract/repel 
gene; Speciesl attract/repel gene; Species2 attract/repel gene; Species3 attract/repel gene; Species4 
attract/repel gene; Species5 attract/repel gene; Species6 attract/repel gene; Species7 attract/repel gene. 
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KEYBOARD CHART 
FILE COMMANDS 
Control-N New Game 
Control-L Load Game 
Control-S Save 

SPEED COMMANDS 

WINDOW COMMANDS 
Control + Hide (keypad plus) 
Control - Close (keypad minus) 

ICON COMMANDS 

ON/OFF TOGGLES 
Control-J Music 
Control-K Sound 
Control-U Update All W 

OPENING MENUS 

OPENING WINDOWS 

Variables 
Phenotype 
Evaluation 
Diversity 
Food Web 
Gene Pool 
Graphs 
History 
Mortality 

Toggles between Plant and Animal in Dashboard. 
Switches between text fields in Save Game dialog. 
Cancels operations, deselects selections. 
Unhighlights highlighted organism. Control-Y Laws 
Move cursor. Control-I Locat 

' Scrolls terrain in Edit Window. Control-D Data 
In Edit Window: 
Hold down while cloning to cause mutation. 
Hold down while using The Carrot to call only Highlighted animal. 
Hold down while raising or lowering Temperature or Moisture to limit effect to 
In the Dashboard: 
Hold down while clicking an On/Off button to turn all plants or animals on or o: 
Hold down while selecting a color to set all plants or animals to that color. 
Hold down while clicking on the Pause button to single-step the simulation one 
Hold down white clicking the Populate... button to randomly populate the wort 
In the Graphs Window: 
Hold down while selecting the Local Species or Information to set all four Selec 
In the Food Web Window (Main Links display): 

i a predator to open the Populatioi 
Control key In Data Logging Dialog Box: 

milding new world to skip display of layer-building, 
kicking Play Scenario in New Game Window to skip thi 

juickly build default world without displaying steps. 


